
PA 800 Plus EmpowerTM Driver
Notes de version

Septembre 2021RUO-IDV-03-9720-FR-B
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Ce guide fournit des informations et les procédures d'installation du PA 800 Plus EmpowerTM

Driver. Le PA 800 Plus EmpowerTM Driver permet d’acquérir des données à partir d’un PA 800
Plus Pharmaceutical Analysis Système utilisant le logiciel Waters EmpowerTM 3 (FR4). Le PA
800 Plus EmpowerTM Driver doit être installé sur le même ordinateur que le logiciel Waters
EmpowerTM.
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Exigences du système d'exploitation
Cette version du logiciel est compatible avec Microsoft Windows 10, 64 bits. Pour les exigences
liées à l’informatique, consultez la section : Configuration requise pour l'ordinateur.

Configuration requise pour l'ordinateur
L'ordinateur doit être conforme à la configuration minimale requise pour Microsoft Windows 10,
64 bits et le logiciel. Pour plus de détails, reportez-vous à la documentation fournie par Waters.

Un port USB libre est également requis.

Configuration de contrôleur validée
Tableau 2-1 Configuration de contrôleur validée

DétailsÉlément

Microsoft Windows 10 Enterprise 2016 LTSBSystème d'exploitation

• Client Oracle version 12.1.0.2.0 pour 32 bits

• du logiciel Waters EmpowerTM

• Pilote National Instruments Software, version 19

Logiciel supplémentaire

Minimum : CPU pour Windows 7 ou 10 Intel 2 Duo, E6400
2.13 GHz

Recommendations : Intel Core 2 Duo, E8400 3.0 GHz

Processeur

Minimum : 4 Go
Recommandation : 8 Go

Mémoire vive (RAM)

Minimum : 25 GoDisque dur

2 Go pour le logiciel Waters EmpowerTMEspace disque disponible

Résolution minimum : 1024 × 768 (hors modules LAC/E)
Recommandation : résolution 1920 × 1080 pourle client

Moniteur

PA 800 Plus EmpowerTM DriverNotes de version
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Tableau 2-1 Configuration de contrôleur validée (suite)

DétailsÉlément

Concentrateur série à 8 portsInterfaces de contrôle en
option

1 adaptateur Ethernet pour la connectivité réseau
Minimum : supérieure à 100 Mbps
Recommandation : 1 Gbps

Adaptateurs Ethernet

Logiciel requis
Le logiciel Waters EmpowerTM 3 doit être installé. Le PA 800 Plus EmpowerTM Driver a été
validé avec le logiciel Waters EmpowerTM 3 (FR4).

Lors de l'évaluation des clients sur l'accès anticipé, les clients ont évalués le PA 800 Plus
EmpowerTM Driver et déterminé qu’il était entièrement compatible avec le logiciel EmpowerTM

3 (FR2) ou version ultérieure.

Pour des fonctions supplémentaires de traitement des données :

• Pour effectuer des calculs d'analyse qualitative pour les applications SDS-MW et cIEF, le
logiciel Waters EmpowerTM GPC est nécessaire.

• Pour réaliser des calculs standards de la pharmacopée tels que la résolution ou le bruit et
la dérive, le logiciel Waters EmpowerTM System Suitability est nécessaire.

Contactez un représentant commercial Water pour acheter une licence pour l'un de ces logiciels.

Version du firmware PA 800 Plus requise
Le PA 800 Plus EmpowerTM Driver a été validé sur les systèmes avec les versions suivantes
du firmware PA 800 Plus. Voir Tableau 2-2.

Tableau 2-2 Version du firmware PA 800 Plus validée

Version du firmwarePA 800 Plus

10.2.3Système PA 800 Plus certifié non-ROHS

10.2.5-RSystème PA 800 Plus certifié ROHS

10.3.7-RCESI 8000 Plus

Si le firmware PA 800 Plus n’est pas l’une des versions validées, il doit être mis à niveau pour
s’assurer que le PA 800 Plus EmpowerTM Driver est compatible avec le logiciel Waters
EmpowerTM et les outils SCIEX utilisés pour effectuer une qualification opérationnelle. Voir
Déterminer la version du firmware à l’aide du logiciel Waters EmpowerTM.
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Déterminer la version du progiciel du système PA 800 Plus
Déterminer la version du firmware à l’aide du logiciel Waters EmpowerTM

1. Ouvrez le logiciel Waters EmpowerTM puis cliquez Run Samples.
2. Sélectionnez le bon système et cliquez OK.
3. Cliquez sur View > System.

Figure 2-1 Dialogue de System Information

4. Cliquez sur Scan Instruments.
Si la colonne OK? affiche Oui, alors le pilote communique avec le module LAC/E.

5. Faites dérouler jusqu’à la bonne colonne Details.
La version du firmware s’affiche avec d’autres informations sur le système.

Figure 2-2 Version du firmware

Si le firmware doit être actualisé, alors contacter un représentant commercial SCIEX.

PA 800 Plus EmpowerTM DriverNotes de version
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Déterminer la version du firmware à l’aide du logiciel 32 Karat

1. Ouvrir le logiciel 32 Karat.

2. Sélectionner le bon instrument pour vous connecter.

Remarque : S’assurer que le système PA 800 Plus et le contrôleur communiquent.

Figure 2-3 Fenêtre du logiciel 32 Karat

3. Cliquez sur Control > Instrument Status > View.
4. Faites défiler pour trouver la version du firmware.
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RUO-IDV-03-9720-FR-B8 / 41

Configuration requise



Figure 2-4 Version du firmware

Si le firmware doit être actualisé, alors contacter un représentant commercial SCIEX.
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Rechercher les pilotes installés précédemment
1. Déterminez si le pilote Beckman Coulter PACE MDQ Control for Waters Empower est

installé.

a. Cliquez sur Control Panel > Programs and Features.
b. Recherchez le logicielBeckmanCoulter PACEMDQControl forWaters Empower.

Le cas échéant, désinstallez-le. Consultez Désinstaller le pilote du logiciel Beckman
Coulter PACE MDQ Control for Waters Empower.

2. Déterminez si la version correcte du pilote National Instruments Software est installée.

Remarque : Le pilote PA 800 Plus EmpowerTM Driver nécessite le pilote de logiciel
National Instruments version 19.0. Si une autre version est installée, elle doit être
supprimée.

a. Cliquez sur Control Panel > Programs and Features.
b. Recherchez National Instruments Software.

Si le numéro de version n'est pas 19.0 (ou si aucun numéro de version n'est affiché),
désinstallez-le. Consultez Désinstaller les versions précédentes du pilote National
Instruments Software.

Désinstaller le pilote du logiciel BeckmanCoulter
PACE MDQ Control for Waters Empower
1. Fermez tous les programmes ouverts du logiciel Waters EmpowerTM.

2. Cliquez sur Control Panel > Programs and Features.
3. Cliquez sur Beckman Coulter PACE MDQ Control for Waters Empower software,

puis sur Uninstall/Change.
La fenêtre InstallShield Wizard s’ouvre.

4. Cliquez sur Remove, puis sur Next.
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Figure 3-1 Assistant Beckman Coulter PACE MDQ Control for Waters Empower
InstallShield

5. Dans le message qui s'ouvre, cliquez sur Yes pour supprimer toutes les fonctions.
6. Lorsque la désinstallation est terminée, cliquez Finish pour fermer la fenêtre InstallShield

Wizard.

7. Dans le panneau de commande Programme et fonctionnalités faites un clic droit,
sélectionnez Refresh, puis vérifiez qu’il Beckman Coulter PACE MDQ Control for
Waters Empower software n’apparaît plus.
Si le pilote est toujours affiché dans le panneau de commande, répétez la procédure
pour désinstaller le pilote.

Désinstaller les versions précédentes du pilote
National Instruments Software
Remarque : Le pilote PA 800 Plus EmpowerTM Driver nécessite le pilote de logiciel National
Instruments version 19.0. Si une autre version est installée, elle doit être supprimée.
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11 / 41RUO-IDV-03-9720-FR-B

Instructions d'installation



1. Cliquez sur Control Panel > Programs and Features.
2. Cliquez sur National Instruments Software, puis sur Uninstall/Change.

La fenêtre National Instruments Software s'ouvre.

3. Selon la version du pilote installée, effectuez l'une des opérations suivantes :

• Maintenez la touche Ctrl-Maj enfoncée et appuyez sur la flèche vers le bas pour
sélectionner tous les éléments de la liste, puis cliquez sur Remove.

Figure 3-2 Boîte de dialogue de désinstallation de National Instruments Software

• Cliquez sur Remove All.

Figure 3-3 Boîte de dialogue de désinstallation de National Instruments Software

4. Une fois la désinstallation terminée, cliquez sur Yes pour redémarrer l'ordinateur.
5. Une fois l'ordinateur redémarré, connectez-vous.
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Installer le PA 800 Plus EmpowerTM Driver
Remarque : Le PA 800 Plus EmpowerTM Driver doit être installé sur le serveur Citrix si le PA
800 Plus EmpowerTM Driver fonctionne dans un environnement Citrix.

1. Insérez le DVD PA 800 Plus EmpowerTM Driver dans le lecteur de DVD.

2. PA 800 Plus Empower Driver V1.3.0Accédez au dossier d'installation, puis double-cliquez
setup.exe.
La fenêtre de dialogue Open File - Security Warning s’ouvre.

3. Cliquez sur Run.
L’assistant PA 800 Plus EmpowerTM Driver InstallShield Wizard s’ouvre.

Figure 3-4 Assistant InstallShield Sciex du PA 800 Plus EmpowerTM Driver

4. À la page License Agreement, cliquez sur I accept the terms of the license agreement
puis sur Next.

5. Suivez les instructions qui apparaissent à l'écran pour installer le logiciel. Lorsque vous
y êtes invité, acceptez les valeurs par défaut. Si des avertissements s'affichent au début
de l'installation, ignorez-les.

Installer le pilote National Instruments Software
Le PA 800 Plus EmpowerTM Driver nécessite la version National Instruments Software Driver
version 19.0.

PA 800 Plus EmpowerTM DriverNotes de version
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1. Sur le DVD d’installation due PA 800 Plus EmpowerTM Driver allez jusqu’au fichier
NI-488.2 19.0 Driver puis double-cliquez Install.exe.
La fenêtre de dialogue Open File - Security Warning s’ouvre.

2. Cliquez sur Run.
Le programme d'installation recherche les contrats de licence, puis ouvre la page
suivante.

Figure 3-5 Assistant d’installation NI Package Manager

3. Cliquez sur I accept the above 2 license agreements. puis cliquez sur Next jusqu’à
ce que la page NI Package Manager s’ouvre.

4. Dans le liste Additional items you may wish to install, cliquez sur NI-488.2 .NET
Language Runtime 17.0.1 for .NET Framework 4.5, puis sur Next.

ATTENTION : Erreur de communication potentielle. Veillez à ce que le composant
NI-488.2 .NET Language Runtime 17.0.1 for .NET Framework 4.5 soit sélectionné
avant de cliquer sur OK. Si le composant n’est pas installé, le module LAC/E et
le système PA 800 Plus ne pourront pas communiquer.

Remarque : par défaut, d'autres composants sont sélectionnés dans cette liste. Ils
sont également obligatoires et doivent rester sélectionnés.
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Figure 3-6 Composants .NET requis

5. À la page Agree, cliquez sur I accept the above 2 license agreements. puis sur Next.
6. À la page suivante, cliquez sur I accept the above 2 license agreements. puis sur

Next.
L'installation peut prendre quelques minutes.
Une fois l'installation terminée, un message sur le service de mise à jour NI s'affiche.

Figure 3-7 Message NI Update Service

7. Cliquez sur No.
8. Si le programme d'installation affiche un message sur le programme d'amélioration de

l'expérience client NI, cliquez sur No, I do not want to participate in the NI Customer
Experience Improvement Program, puis sur OK.

9. Cliquez sur Reboot Now pour redémarrer l'ordinateur.
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10. Connectez-vous à l'ordinateur.

Remarque : si une boîte de dialogue vous demandant d'enregistrer le logiciel s'ouvre,
cliquez sur Cancel pour la fermer.
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Utilisez les procédures suivantes pour configurer le logiciel Waters EmpowerTM afin qu'il
fonctionne avec le système PA 800 Plus.

Modifier les unités de pression
Le logiciel Waters EmpowerTM peut afficher la pression en psi ou en millibar. Par défaut, les
unités sont en millibar. Les unités de pression peuvent être modifiées à partir de la station de
travail LAC/E ou le serveur Citrix.

Utilisez la procédure suivante pour modifier les unités.

1. Connectez-vous en tant qu'utilisateur de possédant des privilèges d'administrateur.

2. Fermez le logiciel Waters EmpowerTM.

3. Ouvrez la fenêtre Registry Editor.

a. Cliquez sur Start, tapez R, puis cliquez sur Run.
La boîte de dialogue Run s’ouvre.

b. Tapez regedit.
c. Cliquez sur Yes dans le message qui s'affiche.
La fenêtre Registry Editor s’ouvre.

4. Localisez l'entrée de registre pour les unités de pression.

a. Cliquez sur Edit > Find.
b. (Facultatif) Cliquez sur le dossier HK_LOCAL_MACHINE dans l'arborescence.

Conseil ! La recherche de l'entrée est beaucoup plus rapide lorsque vous
sélectionnez HK_LOCAL_MACHINE.

PA 800 Plus EmpowerTM DriverNotes de version
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c. Dans le champ Find what:, tapez PressureUnitPSI, puis cliquez sur Find Next.

Figure 4-1 Dialogue de Find

La recherche peut prendre un certain temps. Lorsque la clé est trouvée, elle est
mise en surbrillance dans le volet droit de la fenêtre Registry Editor.

Figure 4-2 Registry Editor

5. Modifiez l'entrée de registre.
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a. Double-cliquez sur PressureUnitPSI.
La boîte de dialogue Edit DWORD (32-bit) Value s’ouvre.

Figure 4-3 Boîte de dialogue Edit DWORD (32-bit) Value

b. Dans le champ Value data, saisissez la valeur des unités, puis cliquez sur OK.
• 1 pour psi
• 0 pour mbar

c. Cliquez pour File > Exit enregistrer les modifications et fermez la fenêtre Registry
Editor.

Configurer le serveur d'acquisition
Remarque : configurez le serveur d'acquisition dans le logiciel Waters EmpowerTM 3 (FR4)
avant d'effectuer la procédure suivante. Pour obtenir des instructions, reportez-vous à la
documentation du fabricant fournie avec le logiciel.

1. Double-cliquez sur l'icôneEmpower sur le bureau et connectez-vous en tant qu'utilisateur
disposant de privilèges d'administration.

2. Dans le logiciel Waters EmpowerTM Lancez la boîte de dialogue, cliquez sur Configure
the System.

PA 800 Plus EmpowerTM DriverNotes de version
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Figure 4-4 Waters EmpowerTM Software Start

La fenêtre Configuration Manager s’ouvre.

Remarque : la liste des nœuds de la figure suivante reflète la configuration logicielle
Waters EmpowerTM.
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Figure 4-5 Fenêtre de Configuration Manager

3. Dans le tableau, cliquez avec le bouton droit de la souris sur le nœud à configurer et
sélectionnez Properties.

PA 800 Plus EmpowerTM DriverNotes de version
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Figure 4-6 Dialogue Node Properties, Onglet General

4. Cliquez sur l'onglet Configure DHCP, puis sur Configure DHCP.
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Figure 4-7 Onglet Configure DHCP

La boîte de dialogue Waters DHCP Server Configuration s’ouvre.

PA 800 Plus EmpowerTM DriverNotes de version
23 / 41RUO-IDV-03-9720-FR-B

Configurer le logiciel Waters EmpowerTM



Figure 4-8 Boîte de dialogue Waters DHCP Server Configuration

5. Si le pilote Beckman Coulter PACE MDQ Control for Waters Empower Software a été
précédemment installé, supprimez tous les instruments CE existants dans la liste. Cliquez
sur BCPACEMDQ dans la boîte de dialogue, puis cliquez sur Remove.

6. Cliquez sur Add.
La boîte de dialogue Add IP Address s’ouvre.

7. Mettez à jour les champs de la boîte de dialogue comme suit.

Figure 4-9 Boîte de dialogue Add IP Address

a. Laissez le champ IP Address vide. Non requis pour un système PA 800 Plus.
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b. Laissez le champMACAddress vide. Ceci n’est pas requis et est automatiquement
définie sur 00-00-00-00-00-00.

c. Cliquez sur Instrument Type et sélectionnez PA800PLUS dans la liste.

d. Dans le champ Serial Number/Unique Name, tapez.
e. Cliquez sur OK.
Si un message concernant l'adresse MAC s'affiche, ignorez le message, saisissez un
numéro dans le champ MAC Address, puis cliquez sur OK.

8. Si le pilote Beckman Coulter PACE MDQ Control for Waters Empower Software a été
précédemment installé, cliquez sur l'onglet Instruments.

Figure 4-10 Onglet Instruments

9. Supprimez tous les instruments précédemment configurés et associés au pilote Beckman
Coulter PACE MDQ Control for Waters Empower Software.
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a. Cliquez sur la ligne contenant l'instrument à supprimer, puis cliquez sur Remove
Instrument.
Les instruments précédemment configurés contiennent BCPACEMDQ dans la
colonne Type.

Figure 4-11 Message de confirmation

b. Cliquez sur Yes dans le message qui s'affiche, puis cliquez sur Yes dans le message
qui suit.

c. S'il y a des instruments supplémentaires avec BCPACEMDQ dans la colonne Type,
répétez la procédure pour les supprimer.

10. Cliquez sur OK.
La boîte de dialogue Node Properties se ferme.

11. Si un second système PA 800 Plus doit être connecté au module LAC/E, répétez cette
procédure, mais à l'étape 7, tapez 2Serial Number/Unique Name dans le champ.

Remarque : les étapes supplémentaires requises pour configurer le second système
PA 800 Plus doivent être effectuées par un technicien de service SCIEX. Contactez
l'assistance technique de SCIEX à l'adresse suivante : sciex.com/request-support.
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Configurer un nouveau système
chromatographique
Le logiciel Waters EmpowerTM est conçu pour la chromatographie. Par conséquent, tout
instrument connecté au logiciel est appelé « système chromatographique ». Le système PA
800 Plus doit être configuré en tant que système chromatographique avant de pouvoir être
utilisé.

1. Dans la fenêtre Configuration Manager, cliquez sur File > New > Chromatographic
System.

Le New Chromatographic System Wizard s’ouvre.

Figure 4-12 Page Type Entry

2. Cliquez sur Create New System, puis sur Next.

Remarque : la liste des nœuds de la figure suivante reflète la configuration logicielle
Waters EmpowerTM.
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Figure 4-13 Page Select Server

3. Cliquez sur le nœud avec le système PA 800 Plus, puis cliquez sur Next.
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Figure 4-14 Page System Selection

4. Dans la liste Available Instruments à gauche, cliquez sur PA800PLUS#1, faites-le
glisser vers la liste New System Instruments à droite, puis cliquez sur Next.

5. Mettez à jour les champs de la page comme suit.
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Figure 4-15 Page Access Control

a. Share Systemwith Other Network Users: cochez cette case pour autoriser d'autres
utilisateurs du réseau à accéder au système.

b. Allowed Access: sélectionnez les types d'utilisateurs autorisés à accéder au
système. Vous avez le choix entre Owner Only, Owner and Group(s), ou Owner,
Group, and World. Pour les deux derniers, sélectionnez les groupes dans la liste
Allow Access to Group(s).

c. Allow Access to Group(s): sélectionnez les groupes autorisés à accéder au
système.

Vous devez sélectionner au moins un groupe.

d. Password Protect System Access: sélectionnez Password Required pour
demander un mot de passe. Dans les champs Password et Confirm Password,
saisissez le mot de passe contenant jusqu'à 30 caractères.

e. Cliquez sur Next.
6. Mettez à jour les champs de la page comme suit.
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Figure 4-16 Page Name Selection dans le New Chromatography System Wizard

a. System Name: saisissez le nom du système contenant jusqu'à 30 caractères. Le
nom est utilisé dans la base de données Empower et la fenêtre Configuration
Manager.

b. Online: cochez cette case pour mettre le nouveau système en ligne.
c. SystemComment: (facultatif) saisissez des commentaires ou d'autres informations

d'identification pour le système, en utilisant jusqu'à 250 caractères.

d. Cliquez sur Finish.
e. Si un message sur un système existant configuré dans un autre système en ligne

s’affiche, cliquez sur OK.

Définir les plateaux d'échantillons et de tampons
Dans le logiciel Waters EmpowerTM, les plateaux d'échantillons et de tampons du système PA
800 Plus sont appelés « plaques ». Les plaques doivent être définies dans le logiciel Waters
EmpowerTM. Pour simplifier ce processus, SCIEX fournit des fichiers texte avec les informations
requises qui peuvent être importées.

1. Insérez le DVD de PA 800 Plus EmpowerTM Driver dans le lecteur de DVD.
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2. Dans la boîte de dialogue de démarrage du logiciel Waters EmpowerTM cliquez sur
Configure the System.

La fenêtre Configuration Manager s’ouvre.

3. Cliquez sur Plate Types pour afficher les plaques déjà définies.

Figure 4-17 Types de plaque dans la fenêtre Configuration Manager

4. Créez la plaque pour le plateau de tampons.

a. Cliquez avec le bouton droit de la souris dans le tableau, puis sélectionnez Import
from Text.

b. Cliquez sur Browse puis allez jusqu’au fichier PA800Plus Buffer Tray.txt sur le DVD
pilote PA 800 Plus EmpowerTM Driver.

Remarque : si le DVD n'est pas disponible, une copie du fichier est incluse dans
ce document. Copiez le contenu, puis collez-le dans un fichier texte. Voir Fichiers
de définition de la plaque.

c. Tapez PA 800 Plus Buffer Tray dans le champ New Plate Type Name, puis cliquez
OK.
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Figure 4-18 Dialogue Import Plate Type From Text File

Le plateau de tampons et ajouté à la liste dans la fenêtre Configuration Manager.

5. Répétez l'étape 4 pour créer les plateaux d'échantillons.

• Pour le plateau d’échantillons de 48 fioles, sélectionnez le fichier PA800Plus Sample
Tray.txt puis le nom de la plaque PA 800 Plus Sample Tray.

• Pour le plateau d’échantillons de 96 fioles, sélectionnez le fichier PA800Plus 96 Well
Sample Tray.txt puis le nom de la plaque PA 800 Plus 96 Well Sample Tray.

Comme pour le plateau de tampons, si le fichier de définition de la plaque n'est pas
disponible, une copie est disponible dans ce document. VoirFichiers de définition de la
plaque.

Remarque : le fichier de définition pour la plaque d'échantillonnage de 96 puits est
destiné à une plaque de 96 puits SCIEX standard (réf. 609844). Pour utiliser une plaque
de 96 puits d'un autre fabricant, cliquez sur File > New > Plate Type dans la fenêtre
Configuration Manager, puis définissez la plaque manuellement.

6. Si le pilote du logiciel Beckman Coulter PACE MDQ Control for Waters EmpowerTM Est
déjà installé, alors supprimez toutes les plaques qui ont été créées pour être utilisées
avec le pilote. Cliquez avec le bouton droit de la souris sur le numéro de ligne de la
plaque, puis sélectionnez Delete.

7. (Facultatif) Pour afficher des informations détaillées sur une plaque, cliquez avec le
bouton droit de la souris sur le numéro de ligne de la plaque, puis sélectionnez
Properties.

8. (Facultatif) Pour supprimer une plaque, cliquez avec le bouton droit de la souris sur le
numéro de ligne de la plaque, puis sélectionnez Delete.
Seules les plaques ajoutées par un utilisateur peuvent être supprimées. Les plaques
prédéfinies ne peuvent pas être supprimées.
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9. Cliquez sur File > Exit pour fermer la boîte de dialogue Configuration Manager.
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• Si le câble d'interface GPIB est retiré du module LAC/E, la communication avec le système
PA 800 Plusest perdue. Connectez le câble d'interface GPIB, puis redémarrez le module
LAC/E.

• Dans une méthode de jeu d'échantillons, toutes les valeurs du champ Injection Volume
sont ignorées. En revanche, le logiciel Waters EmpowerTM utilise le paramètre Duration de
l'événement d'injection pour déterminer le volume d'injection.

• Dans un Inject Pressure Capillary Fill, une erreur sera provoquée si sample lid est
sélectionné pour les positions du plateau. Au lieu de cela, sélectionnez Sample comme
position du plateau et réglez l'incrémentation de la fiole sur 1.

Remarque : Il est demandé à l'utilisateur de programmer une méthode spécifique s'il est
demandé de retourner une fiole.
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Cette section comprend les définitions des plaques pour le plateau de tampons, le plateau
d'échantillons et le plateau d'échantillons de 96 puits SCIEX. Ces plaques doivent être définies
dans le logiciel Waters EmpowerTM.

Les fichiers doivent être installés lors de l'installation du pilote PA 800 Plus EmpowerTM Driver.

S'ils sont manquants et si les plaques doivent être définies, copiez le texte, collez-le dans un
éditeur de texte, puis enregistrez le fichier.
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Fichier de définition de la plaque pour le plateau
de tampons PA 800 Plus
Empower Profile for Plate Type: CE Buffer Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 85.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 9.00
  Top Left Well Y Location: 9.00
  Well Diameter: 12.00
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 6
  Row Spacing: 13.40 mm
  Number of Columns: 6
  Column Spacing: 13.40 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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Fichier de définition de la plaque pour le plateau
d'échantillons PA 800 Plus
Empower Profile for Plate Type: CE Sample Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 128.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 9.00
  Top Left Well Y Location: 17.10
  Well Diameter: 12.00
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 8
  Row Spacing: 13.40 mm
  Number of Columns: 6
  Column Spacing: 13.40 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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Fichier de définition de la plaque pour le plateau
d'échantillons de 96 puits PA 800 Plus
Empower Profile for Plate Type: 96-Well Sample Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 128.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 11.00
  Top Left Well Y Location: 14.50
  Well Diameter: 6.80
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 12
  Row Spacing: 9.00 mm
  Number of Columns: 8
  Column Spacing: 9.00 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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Formation destinée aux clients
• En Amérique du Nord : NA.CustomerTraining@sciex.com

• En Europe : Europe.CustomerTraining@sciex.com

• En dehors des États-Unis et de l'Amérique du Nord, visitez le site sciex.com/education pour
obtenir les coordonnées.

Centre d'apprentissage en ligne
• SCIEX Now Learning Hub

Acheter des consommables
Commandez à nouveau les consommables SCIEX en ligne à l'adresse store.sciex.com. Pour
passer une commande, utilisez le numéro de compte, indiqué sur le devis, la confirmation de
commande ou les documents d'expédition. La boutique en ligne SCIEX se limite actuellement
aux États-Unis, au Royaume-Uni et à l'Allemagne, mais sera bientôt disponible dans d'autres
pays. Pour les clients d'autres pays, contactez le représentant SCIEX local.

Assistance technique SCIEX
SCIEX et ses représentants disposent de personnel dûment qualifié et de spécialistes techniques
dans le monde entier. Ils peuvent répondre aux questions sur le système ou tout problème
technique qui pourrait survenir. Pour plus d'informations, consultez le site Web SCIEX à
l'adresse sciex.com ou choisissez parmi les options suivantes pour nous contacter :

• sciex.com/contact-us

• sciex.com/request-support

Cybersécurité
Pour obtenir les informations les plus récentes sur la cybersécurité des produits SCIEX,
consultez la page sciex.com/productsecurity.
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Documentation
Cette version du document remplace toutes les versions précédentes de ce document.

Adobe Acrobat Reader est nécessaire pour afficher ce document sous forme électronique.
Pour télécharger la dernière version, accéder à https://get.adobe.com/reader.

Pour trouver la documentation du logiciel, consulter les notes de version ou le guide d'installation
du logiciel fourni avec ce dernier.

Pour trouver la documentation du matériel, reportez-vous au DVD Customer Reference fourni
avec le système ou le composant.

Les dernières versions de la documentation sont disponibles sur le site Web SCIEX, à l'adresse
sciex.com/customer-documents.

Remarque : Pour demander une version imprimée gratuite de ce document, contacter
sciex.com/contact-us.
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